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МОДЕЛЬНОЕ УПРАВЛЕНИЕ ТОЧНОСТЬЮ 

 ОБРАБОТКИ РЕЗАНИЕМ 

 

Введение 

 

Программный комплекс Matlab/Simulink предназначен для решения 

математических, инженерных и других задач. При изучении дисциплины 

«САПР информационно – измерительной техники» пакет используется для 

решения задач анализа динамических систем автоматического управления 

объектами и процессами.  

MATLAB – это матричная лаборатория, матричные объекты, мат-

ричные алгоритмы и матричные вычисления. С точки зрения теории авто-

матического управления, параметры состояния объекта – это матрица. 

Строка это вектор, или иначе матрица, состоящая из одной строки и задан-

ного числа колонок. Одно число это тоже матраца единичной размерности. 

Данное представление чисел основано на применении матричных опера-

ций при выполнении математических расчетов. Именно это и послужило 

основанием при выборе названия пакета. 

Особый интерес для инженеров представляет пакет Simulink, разра-

ботанный специально для моделирования динамических систем. Он имеет 

библиотеку стандартных графических блоков, с встроенными математиче-

скими функциями. Работа по созданию модели процесса заключается в 

выборе блока из библиотеки, его перемещения с помощью мыши в окно 

модели и соединения блоков линиями. По завершению этого процесса 

имеем модель экономической системы, которую запускаем с помощью ко-

манды Start и наблюдаем результаты моделирования в окнах графопо-

строителей и цифровых дисплеев. 

В пособии дается краткая технология работы по созданию моделей 

объектов, вполне достаточной для выполнения лабораторной работы.   

 

 

1. Прикладной пакет Simulink 

 

Simulink - это компьютерная программная система для моделирова-

ния систем управления.  Simulink работает под управлением MATLAB и 
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использует для моделирования все его возможности. Им моделируют ли-

нейные, нелинейные, непрерывные, дискретные и гибридные системы. 

    Модель исследуемой системы составляется в виде блок-схемы. 

Блоки переносятся мышью из библиотеки типовых блоков Simulink, яв-

ляющихся моделями элементов технических и экономических систем. Ка-

ждый типовой блок является объектом с графическим начертанием, графи-

ческим и математическим  символом, выполняемой программой и число-

выми или формульными параметрами. Блоки  соединяются линиями, ото-

бражающими движение материальных, финансовых и информационных 

потоков между объектами. 

    Модели могут быть иерархическими , т.е. включать подсистемы в 

виде одного блока. Двойным щелчком мыши на блоке подсистемы откры-

ваем содержимое этой подсистемы( более низкий уровень иерархии). 

     После построения модели можно моделировать, используя раз-

личные методы интегрирования дифференциальных управлений, как из 

меню Simulink, так и  командой строки MATLAB. Используя блок Scope 

(графопостроитель) или Display (числовое отображение), можно посмот-

реть результаты моделирования.  

      Результаты моделирования могут быть переданы в рабочую об-

ласть MaTLAB для последующей обработки и визуализации. Рабочая об-

ласть (Workspace) -  это оперативная память MATLAB, она энергозависи-

ма. В ней сохраняются все результаты моделирования, пока питания ком-

пьютера включено. 

 

1.1 Запуск Simulink 

 

 Есть два вариант запуска SIMULINK: 

1. В командной строке окна MATLAB ввести команду SIMULINK. 

2. В строке инструментов главного окна MALAB рис. 1, щелкнуть по 

кнопке SIMULINK  (зеленая пиктограмма с красным пятнышком слева 

внизу, слева от знака”?”) 

 

1.2 Браузер библиотеки блоков Simulink 

 

После открытия SIMULINK на экране появиться броузер библиотеки 

блоков, вид которого показан на рис. 2. 
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Браузер изображает библиотеки блоков тулбоксов ( в том числе  и 

библиотеки SIMULINK)  в виде трехуровневого иерархического древа. 

Уровни иерархии следующие:  

 

 

                    
 

Рис. 1. Главное окно Matlab 

 

 Тулбокс ( например SIMULINK)  

 Библиотека ( например Continuous ) 

 Блок ( например Integrator)  

Для открытия соответствующего уровня  иерархии служит знак “+” 

слева от имени тулбокса или библиотеки. 

В верхнуй части окна браузера расположены три кнопки и одна поле 

ввода: 

 Создать новую модель (изображен белый лист) 

 Открыть существующею модель ( изображена открытая 

желтая книга); 

 Зафиксировать окно браузера библиотеки на переднем 

плане                ( похожа на катушку для ниток)  

 Поиск блока( find) 

Для поиска необходимо ввести в поле справа от кнопки имя или 

часть имени блока. После нажатия кнопки блок будет найден. 
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В правом окне браузера показано графическое  изображение блоков 

с формулами математической модели блоков или графическим типом вы-

рабатываемого сигнала и названием ( именем) типового блока. 

При разработке модели мы будем мышью перетаскивать картинки 

блоков из библиотеки в окно нашей модели. 

 

 

                     
 

                        Рис. 2. Библиотека типовых блоков Simulink. 

 

1.3 Окно модели и меню 

 

Окно модели SIMULINK – это типовое окно  Windows  приложения. 

В меню Edit добавлены команды установки параметров блоков и 

маскирования подсистем. 
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В меню Simulation  определены команды начала моделирования и 

установки параметров режима моделирования 

 

1.4 Окончание работы Simulink 

 

Окончание работы выполняется традиционными для Windows спосо-

бами закрываются окна Simulink и Matlab. 

 

1.5  Создание новой модели 

 

Для создания новой модели используется традиционная для Windows 

команда меню file>new браузера. Для открытия и редактирования имею-

щейся модели – file>open. При этом раскрывается пустое или заполненное 

модель окно Simulink модели. 

В начале надо ознакомиться с библиотекой блоков. Нарисовать на 

бумаге первую редакцию Вашей блочной модели. Затем садиться за ком-

пьютер. 

Создадим поэтапно простейшую модель беспроцентного накопи-

тельного счета (пенсионного, образовательного, свадебного и др.) как по-

казано на рис. 3. 

 

                          
 

Рис.3. Модель накопительного счета 
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Найдем в библиотеке раздел Continuous (системы непрерывного 

времени) и в нем Inegrator (накопитель). ваших денежных или материаль-

ных средств. 

Мышью перенесем  Inegrator в окно модели, рис. 1.3. Стрелка слева 

указывает на вход интегратора, т.е. возможность подключения входного 

потока средств. Треугольник справа блока является его выходным сигна-

лом и означает запас (сальдо) в накопителе. 

Будем ежемесячно вкладывать в фонд рубли (можно тысячи и мил-

лионы). Для этого из раздела Sources перенесем мышью блок Constant 

Создадим линию потока средств от константы к интегратору. Наве-

дем курсор на выход константы. Курсор из стрелки превращается в крест. 

Протянем мышь до стрелки вход интегратора. Крест раздваивается. От-

пускаем кнопку мыши. Произошло соединение блоков. Исчезли знаки 

входных и выходных портов блоков. 

Для просмотра динамики денежек на нашем счете из библиотеки 

Sinks  перенесем в модель графопостроитель Scope. Соединим с ним  ли-

нией интегратор 

Запустим модель: меню Simulation > Start.  

Просмотрим результаты моделирования. Дважды щелкнем по блоку 

Scope и увидим график, показанный на рис. 4. 

 

                                
 

Рис. 4. График накопления средств в интеграторе 
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Ось времени (10 месяцев) обозначена внизу. Вертикальная ось пока-

зывает накопление денег при вкладах по рублю в месяц. За десять месяцев 

мы накопим 10 рублей. 

 

1.6 Редактирование модели 

 

1.6.1 Выделение объектов 

 

Для выполнения операций над объектами модели (блоками, линия-

ми, именами) их надо выделить (селектировать). 

Выделение одного объекта. Для выделения объекта необходимо 

щелкнуть на нем мышью. Появляются черные метки в углах выделенного 

блока или в начале и конце линии. 

выделение нескольких объектов. Для выделения нескольких объек-

тов по одному необходимо нажать клавишу Shift и щелкнуть на каждом из 

выбираемых объектов. Если щелкнуть по объекту повторно, он становится 

невыделенным. 

Для выделение нескольких объектов  помощью объединительного 

бокса установите курсор в начало области блоков, которые хотите объеди-

нить. При нажатой клавише протащите мышь по диагонали в конец диапа-

зона. Пунктирный прямоугольник окружит выбранный блок и линии. От-

пустите клавишу мыши. Блоки и линии, попавшие в бокс, будут выделены.  

Выделение всей модели. Для всех объектов в активном окне выбери-

те команду Select All в меню Edit или нажмите Ctrl-A. 

 

1.6.2 Операции с блоками 

 

Блоку как объекту присущи методы, т.е. операции, которые может 

выполнять он, либо могут выполняться над ним. Селектируйте блок и вы-

зовите контекстное меню правой кнопкой мыши. Вы увидите набор разре-

шенных над блоком операций.  

Копирование блоков из одного окна в другое 

 При здании и редактировании модели необходимо копировать блоки 

из библиотеки или другой модели в текущую модель. Выполнение данной 

операции состоит из следующих шагов: 
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Откройте требуемую библиотеку или окно модели. 

Переместите требуемый блок в окно создаваемой (редактируемой) 

модели. Для этого установите курсор внутрь пиктограммы блока, нажмите 

и удерживайте левую клавишу мыши. Переместите курсор в требуемое ок-

но и отпустите клавишу мыши. 

Данную операцию можно также выполнить, используя команды 

Copy и Paste из меню Edit: 

Выделите блок, который необходимо скопировать. 

выберите команду Copy из меню Edit. 

Сделайте активным окно, в которое необходимо скопировать блок. 

Выберите команду Paste из меню Edit. 

Simulink присваивает имя каждому из скопированных блоков. Пер-

вый скопированный блок будет иметь такое же имя, как и блок в библио-

теке. Каждый последующий блок будет иметь то же имя с добавлением 

порядкового номера. При копировании блок получает те же значения па-

раметров, что и исходный блок. 

 

Копирование блоков внутри модели 

Нажать клавишу Ctrl. 

Установить курсор на дублируемый блок, нажать левую клавишу 

мыши и переместить копию блока в новое положение. 

Отпустить клавишу мыши и клавишу Ctrl. 

Данную операцию можно выполнить, нажав правую клавишу мыши 

и переместив копию блока в новое положение. 

При дублировании новые блоки получают значения всех параметров 

старых блоков. 

 

Перемещение блоков внутри модели 

Для перемещения одного блока внутри окна модели необходимо пе-

реместить блок в новое положение. Simulink автоматически перерисует 

линии связи к перемещенному блоку. 

Для перемещения нескольких блоков, включая соединительные ли-

нии, необходимо выполнить следующие действия: 

Выделите блоки и линии. 

Переместите блоки и линии в новое положение и отпустите клавишу 

мыши. 
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Изменение размера блока 

Выделить блок. Навести курсор на любую угловую метку. Стрелка 

курсора раздвоится. Левой кнопкой мыши перемещайте ее. Размер блока 

будет меняться. 

 

Удаление блоков 

Выделите удаляемые блоки и нажмите клавишу Del или Backspace 

Можно выбрать команду Clear. 

 

Изменение ориентации блоков 

В исходном положении сигнал проходит через блок слева направо 

(слева – входы, справа – выходы). Для изменения ориентации выделенного 

блока необходимо в меню Format использовать команды: 

Flip Block – поворот блока на 180°. 

Rotate Block – поворот блока по часовой стрелке на 90°. 

 

1.6.3 Имена блоков 

 

Все имена блоков в модели должны быть уникальными и содержать 

минимум один символ. Если блок ориентирован слева направо, то имя на-

ходится по умолчанию под блоком, справа налево – над блоком, сверху 

вниз – слева от блока, снизу вверх – справа от блока. 

Для изменения имени блока необходимо щелкнуть на нем и отредак-

тировать его, используя клавиши управления курсором, клавиши Del, 

Backspace, Enter.для окончания редактирования необходимо щелкнуть в 

любом другом месте окна. 

Для изменения шрифта необходимо выделить блок, затем выполнить 

команду Font  из меню Format .Затем необходимо выбрать шрифт из 

предложенного списка. 

Для изменения местоположения имени выделенного блока есть две 

возможности: 

Левой кнопкой мыши передвинуть имя на противоположную сторо-

ну блока. 

Выполнить команду меню Format >Flip Name. Имя переместится на 

противоположную сторону блока. 
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Спрятать имя можно командой меню Format >Hide Name. Показать 

– командой Format >Show Name. 

 

1.6.4 Задание параметров блока 

 

Установка значений параметров блока выполняется в диалоговом 

окне блока. Для вызова диалогового окна блока необходимо дважды щелк-

нуть на блоке. Пример окна параметров константы приведен на рис 5. У 

константы лишь один параметр – ее значение. У нас стоит один рубль. 

Можем заменить единицу на любое число. Другие блоки могут иметь 

больше параметров, понять и подобрать которые удается не сразу. 

 

1.6.5 Операции с линиями 

 

Сигналы (материальные, денежные и информационные потоки) в 

модели передаются по линиям. Каждая линия может передавать скалярный 

или векторный сигнал. Линия соединяет выходной порт одного блока с 

входным портом другого блока. Линия может также соединять выходной 

порт одного блока с входными портами других блоков посредством раз-

ветвления линии. 

 

                              
 

Рис. 5. диалоговое окно установки параметров блока. 

 

Создание линии между блоками. 

Для соединения выходного порта одного блока с входным портом 

другого блока необходимо выполнить следующие действия: 
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Наведите курсор на выходной порт с правой стороны блока. Стрелка 

заменится перекрестием. 

Левой кнопкой мыши передвиньте курсор к входному порту второго 

блока. Перекрестие заменится двойным перекрестием. 

Отпустите клавишу мыши. Simulink заменит символы порта соеди-

нительной линией с отображением направления передачи сигнала стрел-

кой. 

Линии можно рисовать как от входного порта к выходному, так и , 

наоборот, от выходного порта к входному. 

Simulink рисует горизонтальные и вертикальные сегменты линий. 

Для создания диагональной линии нажмите и удерживайте клавишу Shift 

во время рисования. 

 

Отсоединение блока от линий. 

Нажмите клавишу Shift и переместить блок в новое положение. Свя-

зи разорвутся. Неудобно, что рвутся все связи, а не одна. 

 

Создание новой ветви линии. 

Разветвляющаяся линия начинается на существующей линии и пере-

дает ее сигнал к входному порту другого блока. 

Установите курсор на точку линии, с которой должна начинаться 

разветвляющаяся линия. 

Нажав и удерживая клавишу Ctrl, нажмите и удерживайте левую 

клавишу мыши. 

Проведите линию к входному порту требуемого блока, затем отпус-

тите клавишу Ctrl и клавишу мыши. 

Создание разветвляющейся линии также возможно с помощью пра-

вой клавиши мыши. 

 

Создание сегмента линия 

Линии могут быть нарисованы посегментно. В этом случае для соз-

дания следующего сегмента линии необходимо установить вить курсор в 

конец предыдущего сегмента и нарисовать следующий сегмент. 

 

Перемещение сегмента линии. 

Установите курсор на сегмент, который необходимо переместить. 
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Нажмите и удерживайте левую клавишу мыши. 

Переместите курсор к новому положению сегмента. 

Отпустите клавишу мыши. 

Нельзя переместить сегмент, подключенный непосредственно к пор-

ту блока. 

Разделение линии на сегменты. 

Выделите линию, щелкнув по ней мышью. 

Установите курсор в очку, в которой линия должна быть разделена 

на два сегмента. 

Удерживая клавишу Shift, нажмите и удерживайте клавишу мыши. 

Курсор примет вид окружности. На линии образуется излом. 

Передвиньте курсор в новое положение излома. 

Отпустите клавишу Shift и клавишу мыши. 

 

Перемещение излома линии. 

Установите курсор на излом, затем нажмите и удерживайте левую 

клавишу мыши. Курсор примет вид окружности с центром в точке излома. 

Передвиньте курсор в новую позицию. 

Отпустите клавишу мыши. 

 

1.6.6. Метки линий (сигналов) 

 

Метка (имя, идентификатор) сигнала размещается над или под гори-

зонтальной линией, слева или справа от вертикальной линии. Метка может 

быть расположена в начале, в конце или посередине линии. 

 

Создание метки 

Для создания метки сигнала необходимо дважды щелкнуть на линии 

и ввести текст метки. Щелкнуть надо точно на линии, иначе будет создан 

комментарий к модели, а не метка. Для завершения редактирования щелк-

ните мышью в любой другой части модели. 

 

Редактирование метки  

Для редактирования метки сигнала необходимо ее селектировать 

щелчком мыши. Традиционным для Windows способом изменить текст. 

Щелкнуть мышью за пределами контура метки. 
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Перемещение метки 

Селектировать метку. Протащить за контур стрелкой мыши к новому 

положению у линии. 

 

Копирование метки 

Передвинуть метку при нажатой клавише Ctrl к новому положению 

на линии. 

 

Удаление метки 

Для удаления метки нажмите и удерживайте клавишу Shift, выдели-

те метку и удалите ее, нажав клавишу Del или Backspace 

 

Распространение метки 

Распространение меток линии – это автоматический перенос имени 

метки к сегментам одной линии, разорванным с помощью блоков From, 

Goto, Mux. 

Для распространения метки создайте во втором и последующих сег-

ментах линии метки с именем «<«. После выполнения команды Update Di-

agram из меню Edit в этих сегментах автоматически будут проставлены 

метки. 

 

1.6.7 Комментарии 

 

Комментарии дают возможность вводить текстовую информацию о 

модели и ее составных частях. Комментарии можно вводить в любом сво-

бодном месте модели. 

Для создания комментария дважды щелкните в любом свободном 

месте модели, затем введите комментарий в появившемся прямоугольнике. 

Все операции с комментариями аналогичны операциям с метками, но 

они не привязаны к линиям или блокам. 

Для изменения шрифта необходимо выделить комментарий, затем 

выбрать команду Font из меню Format. Затем выберите в окне диалога 

шрифт, его размер и атрибуты. 

 

1.6.8 Сводные таблицы действий по редактированию блок- схем 
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Обозначения: ЛКМ – левая клавиша мыши, ПКМ- правая клавиша 

мыши. 

Действия мышью и клавиатурой при манипуляции блоками. 

 

Задача Действие 

Выделение блока ЛКМ 

Выделение нескольких блоков Shift + ЛКМ 

Двигать блок Двигать ЛКМ 

Копирование блока Ctrl+ЛКМ и переместить или ПКМ и пе-

реместить 

Соединение блоков ЛКМ 

Отсоединение блоков Shift + переместить блок 

 

Действие мышью и клавиатурой по манипуляции линиями. 

 

Задача Действие 

Выделение линии ЛКМ 

Выделение нескольких линий Shift + ЛКМ 

Создание разветвляющейся линии Ctrl + нарисовать линию или ПКМ + нари-

совать линию 

Создание диагональной линии Shift + нарисовать сегмент 

Перемещение сегмента линии Переместить сегмент 

ЛКМ 

Перемещение излома Переместить излом 

ЛКМ 

Создание сегмента линии Shift + переместить линию 

 

 

Действие мышью и клавиатурой по манипуляции метками сигналов 

Задача Действие 

Создание метки сигнала Двойной щелчок по линии, затем ввести 

метку 

Копирование метки сигнала Ctrl + переместить метку 

Перемещение метки сигнала Переместить метку 

Редактирование метки сигнала Щелкнуть по метке, затем редактировать 

Удаление метки сигнала Shift + щелкнуть по метке, затем нажать 

Del 
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Действие мышью и клавиатурой по манипуляции комментариями 

Задача Действие 

Создание комментария Двойной щелчок в модели, затем ввести 

текст 

Копирования комментария Ctrl + переместить комментарий 

Перемещение комментария Переместить комментарий 

Редактирование комментария  Щелкнуть по тексу, затем редактировать 

Удаление комментария Shift + выделить комментарий, затем на-

жать Del 

 

1.7. Создание подсистем 

 

Если возрастают сложность и размер модели, ее можно упростить, 

сгруппировав блоки в подсистемы. Использование подсистем дает сле-

дующие преимущества: 

- сокращение количества блоков, выводимых в окне модели; 

- объединение функционально-связанных блоков вместе; 

- возможность создания иерархических блок- схем. 

Для создания подсистем существуют следующие возможности: 

- добавить блок Subsystem в модель, затем открыть этот блок и соз-

дать подсистему в открывшемся окне подсистемы; 

- выделить часть блок- схемы модели и объединить ее в подсистему. 

 

Создание подсистемы добавлением блока Subsystem. 

Скопируйте блок Subsystem из библиотеки Connections в модель. 

Откройте блок Subsystem, дважды щелкнув по нему. 

В пустом окне подсистемы создайте подсистему. Используйте блоки 

In и Out для создания входов и выходов подсистемы: 

 

Создание подсистемы группировкой существующих блоков. 

Если модель уже содержит блоки, которые необходимо объединить в 

подсистему, ее можно создать группировкой этих блоков. 

Выделите объединительным боксом блоки и соединительные линии, 

которые необходимо включить в подсистему. 

Выберите команду Create Subsystem из меню Edit. 

Simulink заменит выделенные блоки блоком Subsystem. 
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Если открыть блок Subsystem, Simulink отобразит подсистему. Simu-

link добавляет блоки In и Out для отображения входа и выхода в систему 

более высокого уровня. 

 

1.8. Сохранение модели и вызов текста схемы 

 

Для первой записи модели на диск необходимо выполнить команду 

Save As из меню File. Выбрать папку для файла и дать ему имя. Simulink 

записывает модель путем генерации специального файла с расширением 

.mdl. Его можно просмотреть в редакторе-отладчике MATLAB. Для этого 

в окне текущего справочника MATLAB щелкните мышью по имени файла, 

правой кнопкой вызовите контекстное меню, выберите команду Open as 

Text. Текст файла откроется в редакторе. 

При последующих сохранениях файла используйте команду Save. Она 

перезаписывает содержимое редактируемого файла. 

 

1.9. Печать модели 

 

Выполняется командой Print из меню File либо командой Print в ко-

мандной строке MATLAB. 

 

1.10. Моделирование 

 

Запуск моделирования возможен из меню Simulink, из командной 

строки MATLAB, из программного м-файла, управляющего  

экспериментом. 

Для запуска моделирования из меню Simulink надо выполнить коман-

ду Simulation>Start. Можно использовать кнопки, дублирующие команды 

меню. 

Для запуска моделирования из командной строки вы должны вначале 

загрузить модель, а затем симулировать. Ниже приведен пример этих двух 

команд для модели исследования циклов и кризисов перепроизводства 

parkprdct.mdl. 

>> open_ system (`parkprdct`) 

>> sim (`parkprdct`). 
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Для запуска моделирования из м-файла используются эти же команды 

как функции MATLAB в программах управления экспериментами с моде-

лями Simulink. 

 

1.11. Параметры и методы моделирования 

 

В процессе моделирования нельзя производить изменения структуры 

модели, но возможно изменение параметров блоков. 

Параметры моделирования устанавливаются в диалоговом окне ко-

мандой меню Simulation> Simulation Parameters. 

В окне Solver устанавливается интервал времени моделирования, вы-

бирается алгоритм дискретного или непрерывного времени, выбирается 

численный метод решения дифференциальных или конечно-разностных 

уровней. Устанавливается необходимая точность решения. 

На странице Workspase I/O определяются переменные моделирова-

ния, которые надо сохранить в рабочем пространстве или загрузить из него 

модель Simulink. 

 

Цель работы: Исследование  системы автоматического управления 

точностью токарной обработки с использованием моделей состояния про-

цесса резания.  

2.1. Теоретическое введение 

 

Виртуальный стенд, для исследования точности управления процес-

сом токарной обработки деталей на  станках с ЧПУ, разработан на основе 

математических моделей, описывающих поведение двухмассовой системы. 

Динамика исполнительной части системы управления описывается диффе-

ренциальными уравнениями движения ротора двигателя и обрабатываемой 

детали. 

Модель процесса резания представляет собой отдельное звено, по-

зволяющее аналитически определять усилие резания упругие деформации 

детали и элементов станка, износ инструмента, температурные деформа-

ции детали, учитывать смещение заготовки при установке.  

Модель привода в программной среде Simulink, показанная на рис. 6, 

реализует работу привода 4СК – 23 станка с ЧПУ мод. ТПУ – 125М вы-
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пускаемого серийно. Модель имеет три канала управления для отработки 

управляющих сигналов по координатам X, Y, Z. Для каждой координаты 

имеется свой  блок  privod, блоки регистрации результатов моделирования 

и порты для ввода промежуточных данных с блока Sabsystem. 

Важной особенностью модели, показанной на рис. 6, является нали-

чие модели - наблюдателя, которая не отличается от основной и представ-

ляет ее полный аналог. Наблюдатель формирует моделируемый корректи-

рующий сигнал в виде ошибки привода, возникающей при обработке дета-

лей, которая поступает в сумматор канала, управляющего поперечной по-

дачей. Это позволяет ввести дополнительную составляющую в управляю-

щий сигнал и корректировать глубину резания до прихода реального сиг-

нала обратной связи, регистрирующего истинное положение режущей 

кромки инструмента.  

Таким образом, управляющий сигнал имеет в своем составе упреж-

дение и позволяет управлять положением режущей кромки инструмента до 

появления реальных возмущающих воздействий. 

Управляемым объектом является процесс резания при точении ци-

линдрических заготовок с различными режимами обработки. 

Модель процесса резания выделена в отдельный блок Subsystem, по-

казанный на рис. 6 и  имеет входные и выходные порты для связи с систе-

мой управления.  

Simulink – модель процесса резания разработанная на основании ма-

тематической модели, показана на рис. 7. В модели присутствуют блоки 

задержки сигналов, функции определения упругих деформаций по осям X 

и  Z, блоки определения усилия резания. 

Управляемым объектом является процесс резания при точении ци-

линдрических заготовок с различными режимами обработки. 

Модель процесса резания выделена в отдельный блок Subsystem, по-

казанный на рис. 6 и  имеет входные и выходные порты для связи с систе-

мой управления.  

Simulink – модель процесса резания разработанная на основании ма-

тематической модели, показана на рис. 7. В модели присутствуют блоки 
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задержки сигналов, функции определения упругих деформаций по осям X 

и  Z, блоки определения усилия резания. 

 

 
Рис. 6 

 Структурная схема Simulink модели управления процессом резания 

 

Структурная схема привода, показанная на рис. 6,  состоит из трех 

каналов. Первый канал моделирует привод главного движения, в состав 

которого входят следующие блоки:  

Clok – источник сигнала модельного времени; 

Privod  –  блок управления по координате Z, содержащий Simulink - 

модель, построенную в соответствии с математической моделью привода 

постоянного тока. Блок privod  включает в себя следующие элементы: 

- блоки электронных усилителей;  

- блок моделирующий цепь возбуждения двигателя постоянного то-

ка, (постоянная времени Тв = 0,002с); 
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-  блок моделирующий цепь якоря двигателя (постоянная времени Т 

= 0,05с); 

 

 
 

Рис. 

Simulink – модель процесса резания при точении 

 

- блоки, служащие  для согласования сигналов обратных связей по 

моменту нагрузки, возникающего в зоне резания материала заготовки; 

- блок аналоговый интегратор, на вход которого поступает скорость 

подачи, а на выходе получаем текущую координату вращения заготовки по 

оси Z. 

Блок  Display (рис.1) используется для вывода данных в числовой 

форме, а именно: скорости подачи инструмента, текущей координаты об-

работки, изгибающего момента, создаваемого усилием резания.  

Входными сигналами блока privod (рис.1) являются модельное вре-

мя, (вход 1) и момент нагрузки (вход 2),  который возникает в зоне резания 

материала при отделении стружки.  
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Выходными являются угол поворота и скорость движения заготовки, 

которая регистрируется осциллографом Scope1, показанным на рис.6 

Второй канал осуществляет продольную подачу инструмента отно-

сительно заготовки. Реализует движение модельный блок privod 6. Вход-

ным сигналом блока privod 6 является скорость продольной подачи, пода-

ваемая из блока Constant 7  

Выходными сигналами являются текущая координата движения ин-

струмента вдоль оси  Z и скорость подачи  инструмента S, которые посту-

пают в блок Subsystem , как показано на  рис. 6.   

Третий канал, перемещение инструмента по оси X, регулировка глу-

бины резания. По своему составу он аналогичен каналу подачи инструмен-

та в продольном направлении. Входным блоком канала является блок 

Constant 4,  для ввода величины срезаемого припуска t, затем сигнал идет в 

блок управления privod1, который обеспечивает перемещение инструмента 

на заданную глубину резания. Для регистрации выходного сигнала исполь-

зуется осциллограф Scope2. 

Второй вход блока privod1 используется для ввода сигнала пропор-

ционального моменту сопротивления резанию металла, определяемого в 

блоке Sybsystem.  

Выходной сигнал с блока privod1 Out1 поступает на вход блока 

Subsystem, и для дальнейшей  регистрации графопостроителем XYGraph1 

и осциллографом Scope. Регистрируемые сигналы представляют собой по-

грешность относительного движения инструмента и заготовки в попереч-

ном сечении, по значениям которых определяется точность обработки.  

Разработанный стенд привода является основой для проведения раз-

личных видов экспериментов, в том числе имитационных и позволяет вво-

дить или изменять параметры, как привода, так и процесса резания метал-

ла.  

 

2.2. Моделирование процесса управления точностью токарной 

обработки с наблюдателем состояния процесса резания 

 

Основной задачей проведения модельных экспериментов является 

определение  погрешности обработки деталей с использованием системы 

управления с наблюдателем состояния процесса резания. Исходными дан-
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ными для моделирования являлись схема закрепления заготовки в патроне, 

размеры заготовки, скорость подачи и глубина резания.  

Для моделирования используется управляющая программа, написан-

ная с помощью операторов  Matlab, показанная на рис. 8. Программа  по-

зволяет   автоматически производить смену исходных данных, одновре-

менно в  модели привода и наблюдателе.  

В m – файле за знаком процента всегда идут поясняющие коммента-

рии. Они не являются командами и поэтому компьютером не исполняются. 

В пятой строке модели устанавливается путь файловой системы к 

модели “privod”. 

Седьмая строка командой open system загружает модель в оператив-

ную память. 

 

 
 

Рис. 8. Программа управления экспериментами 

 

Восьмая строка задает план – вектор эксперимента по скорости по-

дачи или может использоваться одно значение подачи   

В строках с 9 по 16 выполняется цикл for для проведения экспери-

ментов при различных величинах глубины резания. При отмене цикла зна-

чение глубины резания устанавливается как постоянная величина. 

В десятой строке командой sim запускается модель и начинается мо-

делирование, имитация обработки заготовок при заданных подаче и глу-

бине резания. 
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В строках 11 и 12 используя данные рабочего пространства Matlab 

(Work spase) записываются в транспонированном виде данные погрешно-

сти обработки и соответствующие им координаты по длине заготовки, ре-

гистрируемые графопостроителями Scope. 

После окончания имитации команда  plot чертит графики зависимо-

сти погрешности обработки от длины заготовки. 

Оператор в строке 14 hold on разрешает дополнить рисунок графи-

ками кривых, рассчитанными для следующих значений циклов по скоро-

сти подачи инструмента. Оператор в строке 17 hold off запрещает допол-

нять рисунок графика, поскольку цикл моделирования завершен командой 

end, записанной в 16 строке. 

В результате моделирования вычислялись усилие резания, упругие 

деформации детали, моменты сопротивления при резании, текущие коор-

динаты движения инструмента, величина погрешности обработки по всей 

длине заготовки. Результаты регистрируются с помощью осциллографов 

Scope, и представляются в графическом виде программой Matlab. 

Величина времени задержки сигнала обратной связи устанавливается 

в соответствующем блоке подпрограммы Subsystem и зависит от частоты 

вращения шпинделя. Режимы обработки, определялись по справочнику 

технолога машиностроителя в соответствии с рекомендациями, исполь-

зуемыми в общем машиностроении.  

В процессе моделирования, использование табличных данных обу-

словлено стремлением  определить эффективность наблюдателей состоя-

ния и установить оптимальные режимы обработки конкретных деталей, 

используя завышенный запас прочности, заложенный в рекомендуемых 

режимах.  

Для ввода режимов резания в структурной схеме, показанной на рис. 

1, предусмотрены соответствующие блоки «Constant», служащие источни-

ками данных, а именно подачи и глубины резания.  Изменение указанных 

параметров выполняется в цикле программы моделирования, что позволя-

ет исследовать динамическое качество системы автоматического управле-

ния. 

Режимы резания для моделирования выберем из таблицы. Например, 

глубина резания составляет  0,1 мм, скорость подачи 0,1 мм/об, число обо-

ротов шпинделя 600 мин 1 .  Обработка производится резцами из твердого 

сплава Т15К6.                          
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При выполнении моделирования виртуальный графопостроитель 

строит графики изменения погрешности детали по длине заготовки при за-

данных исходных данных. Одновременно результаты моделирования запи-

сываются  в рабочую область программы и представляются графически, 

как показано на рис. 9.  

На приведенном рисунке показаны типовые графики изменения по-

грешности по длине заготовки при изменении глубины резания без ис-

пользования сигнала и с использованием корректирующего сигнала на-

блюдателя. Начало обработки на графике происходит с координаты 130 

мм, по оси абсцисс и идет справа налево, как это происходит на станке. 

Погрешность при глубине резания  t = 0,1 мм (рис. 5 а) снижается с 

0,018 мм до 0,004 мм (рис. 5 б), при глубине резания t = 0.2 мм снижается с 

0,027 мм до 0,006 мм, что приводит к снижению в 4,5 раза соответственно.  

 

                             
           а) без наблюдателя                                                 б) с наблюдателем 

 

Рис. 9. Изменение погрешности обработки детали по длине  

 

2.3. Исходные данные для моделирования 

 

Режимы резания и диаметр обрабатываемых заготовок при наружном 

 продольном точении 

 

№ 

п/

п 

Вид обра-

ботки 

Диаметр заго-

товки, мм 

Режимы резания 

Глубина резания      

t  мм 

Подача 

s 

мм/об 

Скорость резания        

V  м/мин 

1 Черновая 10 0,2 0,2 100 
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2 - 10 0,3 0,4 100 

3 - 10 0,4 0,4 100 

4 - 20 0,4 0,3 100 

5 - 20 0,5 0,4 100 

6 - 20 0,5 0,5 100 

7 - 30 0,2 0,3 100 

8 - 30 0,3 0,16 80 

8 - 30 0,4 0,3 100 

9 - 30 0,5 0,16 80 

10 - 30 0,5 0,1 100 

11 - 30 0,5 0,3 100 

12 - 30 0,5 0,5 100 

13 - 30 1,0 0,16 80 

14 - 40 0,2 0,5 100 

15 - 40 0,4 0,6 100 

16 - 40 0,6 0,7 100 

17 - 40 0,8 0,8 100 

18 - 50 1,0 0,6 100 

19 - 50 1,5 1,2 100 

20 Черновая 50 2,0 1,2 100 

21 Чистовая 10 0,1 0,1 100 

22 - 20 0,1 0,1 100 

23 - 30 0,1 0,1 100 

24 - 40 0,1 0,1 100 

 

2.4. Порядок выполнения работы 

 

Ознакомиться с методом повышения точности управления обработ-

кой резанием с использованием моделей состояния. 
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1. Запустить программу   Matlab с помощью ярлыка на рабочем столе 

или из меню Пуск – Программы – Matlab . Запустить  программу nic, нахо-

дящуюся в папке  work  интегрированного пакета Matlab. 

 2. Открыть с помощью пиктограммы пакет Simulink , в котором от-

крыть программу privod.  

3. Выбрать из таблицы режимы резания для обработки детали и вве-

сти в блоки «Подача» и «Глубина» , показанные на рис 6, соответствую-

щие значения. 

4. Запустить программу  nic  в рабочем окне Matlab и получить ре-

шение в виде графика, как показано на рис. 8. 

5. Выполнить моделирование для пяти вариантов значений режимов 

обработки. 

6. Сделать выводы по полученным графикам. 

 

2.5. Отчет по работе 

 

Отчет по работе должен содержать цель работы, исходные данные 

для моделирования, результаты моделирования, выводы по работе.  

 

2.6. Контрольные вопросы: 

 

1. Что понимается под наблюдателем состояния процесса обработки 

резанием и его назначение. 

2. Какие величины используются в качестве исходных данных при 

моделировании. 

3. Назовите основные операторы управляющей программы  nic и их 

назначение. 

4. Назначение блоков Subsystem в программе  nic. 

5. Как изменяется точность обработки деталей при изменении режи-

мов резания. 
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